Point of Sale - PCI DSS Implementation Guide

Point of Sale
Versions 8.0, 9.0, 10.0, 2013

Implementation Guide

Payment Card Industry
Data Security Standard
Copyright and Trademarks

© 2012 Intuit Inc. All rights reserved. Intuit, the Intuit logo, QuickBooks, Quicken, TurboTax, Lacerte, ProSeries, EasyStep and QuickZoom among others, are registered trademarks and/or registered service marks of Intuit Inc. or one of its subsidiaries. Simple Start, Intuit Eclipse and Innovative Merchant Solutions, among others, are trademarks and/or service marks of Intuit Inc. Other parties’ marks are the property of their respective owners.

Introduction

The Payment Card Industry Data Security Standard (PCI DSS) includes requirements for the configuration, operation, and security of payment card transactions in your business.

When you start accepting payment cards you are also agreeing to take the steps necessary to protect your customer’s card data. If you use the QuickBooks POS Merchant Service to authorize and settle credit and/or debit card transactions in QuickBooks Point of Sale, this standard and this implementation guide apply to you.

Compliance to the standard not only is good for business, as it assures your customers that their card information is being handled in a secure manner, but also is fiscally important—a security breach could result in significant fines.¹

When determining the measures that need to be taken for compliance, you need to review your entire system configuration:

- Your operating system (Windows) configuration and account controls
- Your network architecture and, if applicable, remote and wireless access to it
- Implementation of security software, such as antivirus and firewall applications
- Implementation of and access controls to card payment applications (QuickBooks Point of Sale, used in conjunction with the QuickBooks POS Merchant Service, is a card payment application)
- Written policies and procedures for implementing and monitoring all of the above

This guide serves to help you implement QuickBooks Point of Sale and your overall system in such a manner as to be in compliance with the PCI DSS.

Table 1 summarizes the major PCI DSS requirements, what QuickBooks Point of Sale provides to help you meet the requirements, what you are responsible for, and where to get more information on that particular requirement. The remainder of this guide provides recommendations and instructions for your use of QuickBooks Point of Sale in a compliant manner.

Throughout this guide we provide links to Internet sites of providers of security related products and information, and to industry organizations that can provide additional assistance with understanding the PCI DSS requirements. These links are provided for your convenience. Unless specifically stated otherwise, Intuit does not own, endorse, or specifically recommend any of the products or vendors listed. Security recommendations should take into account relevant factors that may be unique to your business.

You can learn more about and get a copy of the PCI DSS standard at the PCI Security Standards Council™ site:

https://www.pcisecuritystandards.org

¹ For details, please consult: https://www.pcisecuritystandards.org
Note: This guide applies specifically to QuickBooks Point of Sale versions 8.0, 9.0, 10.0 and 2013. If you also use QuickBooks financial software, visit the QuickBooks Payment Card Protection Resource Center at http://security.intuit.com/pci-dss.html for details about the PCI DSS features available in the version you have.

Terminology Used in this Guide

PCI DSS: Acronym for Payment Card Industry Data Security Standard, the subject of this guide. Retailers that use applications, like QuickBooks Point of Sale, to process, store, or transmit payment card data to authorize or settle transactions are subject to this standard.

PABP: Acronym for Payment Application Best Practices; a Visa U.S.A standard for validation of payment processing applications, such as QuickBooks Point of Sale. PABP-compliant applications have built-in card protection features, and provide tools and information to help retailers comply with the PCI DSS.

Cardholder data: Cardholder’s name, card type, account number, and expiration date that may be stored on authorized card transactions.

Sensitive authentication data (also called Card swipe data): Card or account verification and PIN information stored in the magnetic stripe on a payment card.

Encryption: Process of encoding data so that it is unreadable to those without the proper permissions or “key” to decode it.

PAN: Acronym for Primary Account Number. Storage of customers’ payment card PANs is the deciding factor if the PCI DSS and PABP standards apply to retailers and application vendors respectively. QuickBooks Point of Sale stores PANs in an encrypted format.

SSL: Secure sockets layer; a common encryption technology used to secure transmissions of data across public networks.

Installation/Upgrading to QuickBooks Point of Sale

Instructions for installing or upgrading to QuickBooks Point of Sale can be found in the printed QuickStart Guide that accompanied your software. Information about signing up for an account with the QuickBooks POS Merchant Service is included in that guide and within the QuickBooks Point of Sale program.

The QuickStart Guide, this guide, and a complete User’s Guide are available in electronic format from the Help menu within QuickBooks Point of Sale (viewing requires Adobe Acrobat Reader).

After successfully upgrading from a previous version, PCI standards require that you securely delete the data file and any backup files in your previous version that might contain cardholder or card swipe data. For additional information about the secure deletion of this data, see Deleting Card Data in Previous Point of Sale Versions later in this guide.
## Table 1: Summary of PCI DSS Requirements

<table>
<thead>
<tr>
<th>Build and Maintain a Secure Network</th>
<th>What QuickBooks Point of Sale provides...</th>
<th>What you need to do...</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Requirement 1:</strong> Install and maintain a firewall configuration to protect cardholder data</td>
<td>Designed to operate securely in a network with firewalls and security devices. Works with several major antivirus and firewall vendors for out-of-the-box compatibility.</td>
<td>Configure the network to block unauthorized traffic. Review and update your firewall configuration and software regularly.</td>
<td>Consult your firewall documentation and vendor web site for best practices consistent with your business needs. Refer to Figure 1 in this guide and read Appendix C in the QuickBooks Point of Sale User’s Guide.</td>
</tr>
<tr>
<td><strong>Requirement 2:</strong> Do not use vendor-supplied defaults for system passwords and other security parameters</td>
<td>Features that require password logins, encrypted files with passwords, and settings for individual or group security access to sensitive program data and features.</td>
<td>Set your own unique user names and passwords on all wired or wireless network devices and at the operating system level. It is strongly recommended that you use complex passwords, especially for system administrators.</td>
<td>See <a href="http://www.staysafeonline.org">www.staysafeonline.org</a> for more information about general security practices. For more detailed guidance, IT professionals may refer to <a href="http://www.cisecurity.org">www.cisecurity.org</a>. This includes specific guidance on Windows and networking configuration best practices.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Protect Cardholder Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Requirement 3:</strong> Protect stored cardholder data</td>
</tr>
<tr>
<td><strong>Requirement 4:</strong> Encrypt transmission of cardholder data across open, public networks</td>
</tr>
</tbody>
</table>
## Maintain a Vulnerability Management Program

<table>
<thead>
<tr>
<th>PCI DSS Requirement</th>
<th>What QuickBooks Point of Sale provides...</th>
<th>What you need to do...</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement 5: Use and regularly update anti-virus software</td>
<td>Designed to operate securely in a network protected with antivirus, anti-spyware, and personal firewall products.</td>
<td>Use well-known and supported security products on all your business computers. Regularly install software updates to Windows, anti-virus software, and other security products.</td>
<td>For recommendations for anti-virus and system security tools, refer to <a href="http://www.ConsumerReports.org">www.ConsumerReports.org</a>, or consult an IT Professional.</td>
</tr>
<tr>
<td>Requirement 6: Develop and maintain secure systems and applications</td>
<td>Stringently tested for security issues before release. Program updates, to address evolving standards, are made available for automatic and manual download. Logs application and data access activities.</td>
<td>Keep your systems current with the latest software updates—operating system, antivirus and firewall applications, and QuickBooks Point of Sale. If possible, test updates on systems other than your production business systems first to be sure they will not affect your ongoing operation.</td>
<td>Microsoft® Windows® Update is available at <a href="http://windowsupdate.microsoft.com">windowsupdate.microsoft.com</a>. Consult other software vendors’ support sites for more information regarding updates and security alerts. IT Professionals should refer to <a href="http://www.cert.org">www.cert.org</a> for regular updates on security patches and alerts. Refer to QuickBooks Point of Sale Updates in this guide.</td>
</tr>
</tbody>
</table>

## Implement Strong Access Control Measures

| Requirement 7: Restrict access to cardholder data by business need-to-know | Blocks all user access to stored cardholder data. Provides access control features to restrict access to financially sensitive information. | Use Windows and QuickBooks Point of Sale administrator accounts only for system configuration tasks. Use a regular user account at all other times. Use QuickBooks Point of Sale security right controls to ensure that your employees have access to data on an as-needed basis. | For information about Windows user accounts, consult your Windows help system. IT Professionals can visit [http://support.microsoft.com/kb/307882](http://support.microsoft.com/kb/307882) for information on the Group Policy Editor. Refer to Implementing Strong Access Control Measures in this guide. |
| Requirement 8: Assign a unique ID to each person with computer access | If logins are required, program enforces unique user names and passwords for access. | Set up each user with a user name and password and then require logins, along with assigned security rights, to restrict access to sensitive data. | Refer to Protecting Your Data with Unique IDs and Passwords in this guide. Refer to the PCI Security Standards for more information, at [www.pcisecuritystandards.org](http://www.pcisecuritystandards.org) |
| Requirement 9: Restrict physical access to cardholder data | Displayed and printed card numbers are masked. Data is stored only on one workstation, facilitating ability to physically secure it. | Physically secure the QuickBooks Point of Sale Server Workstation to keep your data, backups, and reports in a secure location (a locked office is recommended). Use a shredder to dispose of printouts that might contain payment information when no longer needed. | Refer to Limiting Physical Access to Your Data Files in this guide. Refer to [http://www.us-cert.gov/reading_room/CSG-small-business.pdf](http://www.us-cert.gov/reading_room/CSG-small-business.pdf) for more information about physical security and other information security topics. |
## Regularly Monitor and Test Networks

### Requirement 10:
Track and monitor all access to network resources and cardholder data

- **All versions:** Logs access and other data security activities to the Audit Log and/or to the Windows Event log. QuickBooks Point of Sale 2013: To facilitate collecting logs into a central repository, logs are also stored in the log directory.

- **Regularly:** Review the audit log within QuickBooks Point of Sale and the Windows Event log regularly to detect possible instances of unauthorized access to your network or cardholder data. Keep audit logs and backups for at least one year.

- **Refer to:** Review Security Logs Regularly in this Guide.

### Requirement 11:
Regularly test security systems and processes

- **Provides activity logs:** Provides activity logs to assist in your reviews.

- **Follow guidelines:** Follow the guidelines in the PCI Security standards as appropriate for your Merchant Level.

- **Refer to PCI Security standards:** Refer to the PCI Security standards for detailed guidelines on security assessments:
  - [Defining Your Merchant Level Validation Requirements & Procedures](#)
<table>
<thead>
<tr>
<th>PCI DSS Requirement</th>
<th>What QuickBooks Point of Sale provides...</th>
<th>What you need to do...</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Requirement 12:</strong> Maintain a policy that addresses information security</td>
<td>Provides this guide. Facilitates security policies with access controls and audit logging.</td>
<td>Maintain a written policy and training manual for the implementation of security program. Review your security program and network configuration at least once each year.</td>
<td>Refer to <a href="http://www.us-cert.gov/reading_room/CSG-small-business.pdf">http://www.us-cert.gov/reading_room/CSG-small-business.pdf</a> for more information about issues that should be addressed in your security practices. IT Professionals may refer to <a href="http://www.sans.org/resources/policies/">http://www.sans.org/resources/policies/</a> for more information about establishing and maintaining security policies.</td>
</tr>
</tbody>
</table>
Building and Maintaining a Secure Network

Conceptually, your company network should be constructed like the model shown in Figure 1.

To be PCI compliant, you must use the latest encryption options on wireless networking equipment.

Your firewall blocks unsolicited traffic to your network.

Internet

When you conduct payment card transactions over the internet, all data is encrypted using SSL.

Sample Point of Sale Network with Payment Card Processing

Point of Sale Workstations, with up-to-date antivirus and Windows (operating system) software

Figure 1 - PCI-Compliant Network Configuration
Consistent with careful business practices, the PCI standard requires that your network:

- Be protected from unauthorized traffic using a firewall;
- Have anti-virus software installed (and updated regularly);
- Is regularly updated with the latest operating system (Windows) and network software patches to keep your system current.

The following guidelines are general in nature. It is recommended that you consult a qualified network administrator to review your particular network setup for purposes of implementing the best protective measures for your situation.

Build and maintain your network carefully. Your data file on the QuickBooks Point of Sale Server Workstation should be well protected within your network, behind a firewall and should not be stored on systems such as Internet-facing web servers or remote-access servers.

**Remote Network Access**

If you build out or allow remote access to your network, use applications that provide strong encryption, authentication, and access controls into your network. Products should be based on well-known, Internet-standard protocols such as SSL/TLS and SSH.

When QuickBooks Point of Sale connects with online services to conduct payment transactions, they do so using SSL-protected connections. QuickBooks Point of Sale has been constructed to facilitate compliance with PCI requirements in this regard.

QuickBooks Point of Sale does not provide tools or means to remotely access the data stored in your company file. If you use a third-party remote access application to allow yourself, customers, accountants, or technical advisors to access your data, you must make certain that your use of that application ensures that access to cardholder data is performed by, and can be traced to, known and authorized users. Specifically, you should:

- Not use default settings in the remote access application;
- Identify all users with a unique user name;
- In addition to a unique user name, require at least one of the following methods to authenticate users:
  - Passwords. We strongly recommend the use of complex passwords for logins (see Protecting Your Data with Unique IDs and Passwords for more information about establishing complex passwords).
  - Token devices (such as SecureID, certificates, or public key).
- Implement two-factor authentication for remote access to the network by employees, administrators, and third parties. Use technologies such as remote authentication and dial-in service (RADIUS) or terminal access controller access control system (TACACS) with tokens; or VPN (based on SSL/TLS or IPSEC) with individual certificates.
• Authenticate all access to your data; including access by other applications, administrators, and all other users;
• Allow connections only from specific, known IP/MAC addresses;
• Require a Virtual Private Connection (VPN) via a firewall before allowing access;
• Enable encryption of transmitted data;
• Enable account lockout (30 minutes or until administrator resets user ID) after a specified number (maximum 6) of failed login attempts;
• Enable logging of access activities;
• Restrict access to customer passwords to authorized personnel;
• Encrypt all passwords during transmission and for storage on your system;
• Follow good user authentication and password management practices for employees, administrators, advisors, or technical support users. Refer to Protecting Your Data with Unique IDs and Passwords for more information.
• Only allow third parties to connect when needed for business reasons. Access for Intuit and business partners should be deactivated after use.

All non-console administrative access to any systems running QuickBooks Point of Sale must use strong encryption to secure the connection. Non-console administrative access includes remote desktop control software used from the local area network.

Wireless Networks

When you build out a wireless network, consult your networking vendor’s documentation and online resources carefully for optimal security configurations.

If wireless is used or implemented in the payment environment or application, the wireless environment must be configured per PA-DSS version 2.0 - requirement 6. Wireless technology must be securely implemented and transmissions of cardholder data over wireless networks must be secure.

When using wireless networks:

Install and configure perimeter firewalls between wireless networks and systems that store credit card data, and configure firewalls to deny or control any traffic from the wireless environment into the cardholder data storage environment. The traffic allowed into the cardholder data storage environment from the wireless environment must be necessary for business purposes.

Modify default wireless settings, including, but not limited to the following:

• Change default encryption keys upon installation and anytime anyone with knowledge of the encryption keys leaves the company or changes positions
• Change default service set identifier (SSID)
• Change default passwords or passphrases on access points
• Change default SNMP community strings
• Enable WiFi protected access (WPA and WPA2) technology for encryption and authentication
• Update firmware on wireless access points to support strong encryption and authentication (WPA/WPA2)
• Other security related wireless vendor defaults

For wireless networks transmitting cardholder data or connected to the cardholder data environment, implement industry best practices for strong encryption of data transmission and authentication (for example, IEEE 802.11i).

The use of WEP as a security control was prohibited as of June 30, 2010.
Refer to the sources in Table 3 for more information.

Using Firewalls

Firewalls monitor communication traveling through your computer’s ports and block any communication that is not recognized as safe. This provides you with an essential component of the protection you need to minimize your exposure to known and unknown dangers from malicious users.

There are many different firewalls available to you, and they can be either software or hardware-based (for example, many routers have built-in firewalls). On a typical network, there is a single point of connection to the Internet (such as the network server) and this is the critical point requiring a firewall.

In addition to your store’s computer network being protected by a firewall, you also must install firewall software on any wireless, mobile, and employee-owned computers with direct connectivity to the Internet (for example, laptops used by employees), which are also used to access your network.

Any systems containing QuickBooks Point of Sale or storing cardholder data should never be accessible from the Internet. Firewalls should be used to block incoming access to these systems.

Firewalls and QuickBooks Point of Sale

In order to ensure that desired communication is not blocked, your firewall program has to be instructed to allow that communication.

Your QuickBooks Point of Sale software is “white-listed” with several major firewall software vendors, such as McAfee, Symantec, Trend Micro, and Check Point. What this means is that if you use firewall software from one of these vendors, and you keep the firewall software updated, it is pre-configured to recognize QuickBooks Point of Sale and the communications necessary within QuickBooks Point of Sale are automatically allowed.

If you are not using one of the white-list vendors mentioned above, you may need to specify the particular ports and files that will be used by QuickBooks Point of Sale so that
your firewall allows the communication. How this is done will vary depending upon the
particular firewall you are using.

See the Appendix titled “Configuring Firewalls in your QuickBooks Point of Sale User’s
Guide for specific information about the activities and ports used, and some sample
firewall configurations.

You can find out more about industry-certified products from the list of sites listed in
Table 3. Many of the sites listed contain references for further information.
Protecting Cardholder Data

Encrypting Card Information

QuickBooks Point of Sale encrypts the cardholder data stored in your company data with encryption keys using an industry-standard, strong encryption process that meets current PCI DSS requirements. QuickBooks Point of Sale automatically generates new encryption keys at least once per year. No action is required on your part to enable this security feature.

Note: The encrypted cardholder data stored in your company file is not accessible to any QuickBooks Point of Sale user; even the QuickBooks Point of Sale system administrator is blocked from viewing this information. Cardholder data is also not available on QuickBooks Point of Sale reports or in data exports from QuickBooks Point of Sale.

Note: QuickBooks Point of Sale 2013 only stores the card data for voice authorization transactions. Once voice authorization transaction successfully processed, credit card data is deleted from database immediately.

Additional security measures to protect cardholder data and comply with PCI DSS standards include the following.

- The ability for you to manually generate new encryption keys if you suspect your data has been compromised or an unauthorized attempt to access the data was made. See If You Suspect a Security Breach.
- Old encryption keys are automatically deleted anytime new keys are generated.
- Card information is automatically stripped from stored transactions at sixty days of age in order that cardholder data is not retained any longer than necessary.
- In recent versions of QuickBooks Point of Sale, card swipe data is not stored. However, some previous versions may contain stored cardholder or swipe data. If you upgraded from a previous version, this data must be securely deleted to be in compliance with PCI DSS requirements. See Deleting Card Data in Previous QuickBooks Point of Sale Versions.
- An Audit Log records all activities related to data access, payment card transactions, and changes to card encryption keys. In addition, failed attempts to log in to QuickBooks Point of Sale are logged in the Windows Event Log. Starting from QuickBooks Point of Sale 2013, an additional centralized log is being kept for the same information across all company files. This is to allow sending audit logs to a centralized repository of the merchant’s logs.
If You Suspect a Security Breach

If an unauthorized attempt to access your data has been made or you are aware of an actual breach of your security system that has compromised data belonging to you, your business, or your customers, you should immediately:

1. Backup your data file and store the backup in a secure location.
2. If you suspect involvement by a specific user or users, delete or disable the user account(s). This will block further access to your data by the user(s) while you have an opportunity to investigate.
3. Review the Audit Log and Windows Event Log to examine entries related to the suspicious activity and users.
4. Change your Windows and QuickBooks Point of Sale administrator passwords. It is recommended you also change, or require to be changed, all other user passwords.
5. Manually generate new encryption keys:
   a. Log in to QuickBooks Point of Sale as the SysAdmin user.
   b. From the QuickBooks Point of Sale File menu, select Utilities.
   c. Select Generate New Credit Card Keys.
      The new keys are used to encrypt all new transactions. In addition, stored transactions are re-encrypted with the new keys. The previous keys are destroyed and are unrecoverable. A confirmation message is displayed upon successful update of the stored card transactions.
   d. Log off the SysAdmin user.

See Appendix B: Encryption Key Management for additional Key Management information.

Deleting Card Data in Previous QuickBooks Point of Sale Versions

When you upgrade from a previous version of QuickBooks Point of Sale, the program makes a copy of the data file from your previous version and converts it for compatibility with the current version. All card swipe data is stripped from the converted data and cardholder data on authorized transactions less than 60 days old are re-encrypted with a new set of keys.

However, your previous version data file(s) and any backups of those files may still contain stored card swipe or cardholder data. After you have successfully upgraded to the current version of QuickBooks Point of Sale, secure deletion of the card data in your previous version(s) is absolutely necessary for PCI DSS compliance.
What is secure deletion?

Secure deletion of data can be compared to the shredding of confidential papers. If you simply throw such papers into the trash, they are vulnerable to recovery and use by ill-intentioned persons. But a good shredder will make it near impossible to ever read the papers again. Likewise, in electronic files, secure deletion overwrites the data with a series of random characters multiple times, until the original data can no longer be recovered.

Secure Deletion Tools

Standard file deletion tools typically do not meet the secure deletion standard—they are equivalent to throwing your data into a trash can.

You must obtain and use a secure deletion application for this purpose or utilize a qualified third-party that offers this service. You can find secure deletion utilities on the Internet. Some of these utilities are available free or at minimal cost. One such utility is MS SDelete. For more information or to download this utility visit: http://technet.microsoft.com/en-us/sysinternals/bb897443

Microsoft’s SDelete is a command line utility that deletes files and directories so they cannot be recovered.

To securely delete a file using SDelete, use the command:
> sdelete <file>

To securely delete a directory using SDelete, use the command:
> sdelete –r <directory>

Use caution when using secure deletion tools as data removed with a secure deletion tool is permanently deleted. Double check command line parameters to verify you are not deleting files you don’t intend to delete.

Alternatively, use your Internet browser to search for “secure file deletion” to locate other secure delete applications. When selecting a program, look for one that:

- Supports your version of Windows;
- Meets the latest Department of Defense (DOD) standards for secure deletion.

What files do I need to delete?

Table 2 lists the previous version data and backup file locations that should be securely deleted.

If you installed or made backups to other places besides the default locations, you must locate and securely delete the files in those alternate locations as well.

QuickBooks Point of Sale data and backup files can be identified by the .qpb file extension. The actual backup file name is not fixed and if you specified something different when backups were made, be sure to adjust this process to delete those files.
<table>
<thead>
<tr>
<th>Version</th>
<th>Type</th>
<th>Default Location</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 – 3.0 Data</td>
<td>C:\Program Files\Intuit\qbpos\RPRO\EFT\Data</td>
<td>Securely delete entire folder.</td>
<td></td>
</tr>
<tr>
<td>1.0 – 3.0 Backup</td>
<td>C:\Program Files\Intuit\qbpos\RPRO\Backup\qbpos.qpb</td>
<td>Optional secure deletion. These backups do not contain credit card data.</td>
<td></td>
</tr>
<tr>
<td>4.0 Data</td>
<td>C:\Program Files\Intuit\QuickBooks Point of Sale 4.0\Data&lt;Company name&gt;</td>
<td>Securely delete entire data folder or the data sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>4.0 Backup</td>
<td>C:\Program Files\Intuit\QuickBooks Point of Sale 4.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>5.0 Data</td>
<td>C:\Program Files\Intuit\QuickBooks Point of Sale 5.0\Data&lt;Company name&gt;</td>
<td>Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>5.0 Backup</td>
<td>C:\Program Files\Intuit\QuickBooks Point of Sale 5.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>6.0 Data</td>
<td>Windows XP, Windows Server 2003: C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 6.0\Data&lt;Company name&gt; Windows Vista, Windows 7, Windows Server 2008: C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 6.0\Data&lt;Company name&gt;</td>
<td>Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>6.0 Backup</td>
<td>Windows XP, Windows Server 2003: C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 6.0\Data&lt;Company name&gt;\Backup*.qpb Windows Vista, Windows 7, Windows Server 2008: C:\Users\Public\Public</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Type</td>
<td>Default Location</td>
<td>Instructions</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>7.0</td>
<td>Data</td>
<td>Windows XP, Windows Server 2003:</td>
<td>Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 7.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows Vista, Windows 7, Windows Server 2008:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 7.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td></td>
</tr>
<tr>
<td>7.0</td>
<td>Backup</td>
<td>Windows XP, Windows Server 2003:</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 7.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows Vista, Windows 7, Windows Server 2008:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 7.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td></td>
</tr>
<tr>
<td>8.0</td>
<td>Data</td>
<td>Windows XP, Windows Server 2003:</td>
<td>Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 8.0\Data&lt;Company name&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows Vista, Windows 7, Windows Server 2008:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 8.0\Data&lt;Company name&gt;</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Type</td>
<td>Default Location</td>
<td>Instructions</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>------------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| 8.0     | Backup | Windows XP, Windows Server 2003:  
C:\Documents and Settings\All Users\Shared Documents  
\Intuit\QuickBooks Point of Sale 8.0\Data\<Company name>\Backup\*.qpb  
Windows Vista, Windows 7, Windows Server 2008:  
C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 8.0\Data\<Company name>\Backup\*.qpb | Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data. |
| 9.0     | Data  | Windows XP, Windows Server 2003:  
C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 9.0\Data\<Company name> | Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data. |
| 9.0     | Backup | Windows XP, Windows Server 2003:  
C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 9.0\Data\<Company name>\Backup\*.qpb  
Windows Vista, Windows 7, Windows Server 2008:  
C:\Users\Public\Public Documents\Intuit\QuickBooks Point of Sale 9.0\Data\<Company name>\Backup\*.qpb | Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data. |
| 10.0    | Data  | Windows XP, Windows Server 2003:  
C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks  | Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data. |
<table>
<thead>
<tr>
<th>Version</th>
<th>Type</th>
<th>Default Location</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point of Sale 10.0</td>
<td>Data</td>
<td>Windows Vista, Windows 7, Windows Server 2008: C:\Users\Public\Public Documents Intuit\QuickBooks Point of Sale 10.0\Data&lt;Company name&gt;</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td>10.0</td>
<td>Backup</td>
<td>Windows XP, Windows Server 2003: C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 10.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td>QuickBooks Point of Sale 2013</td>
<td>Data</td>
<td>Windows XP, Windows Server 2003: C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 11.0\Data&lt;Company name&gt;</td>
<td>Securely delete entire data folder or just the data sub-folders for specific company files that contain cardholder data.</td>
</tr>
<tr>
<td>QuickBooks Point of Sale 2013</td>
<td>Backup</td>
<td>Windows XP, Windows Server 2003: C:\Documents and Settings\All Users\Shared Documents\Intuit\QuickBooks Point of Sale 11.0\Data&lt;Company name&gt;\Backup*.qpb</td>
<td>Securely delete entire data folder or just the backup sub-folders for specific company files that contain cardholder data.</td>
</tr>
</tbody>
</table>
Transmitting and Sharing of Cardholder Data

QuickBooks Point of Sale encrypts all cardholder data stored in your company file. When connecting with online services to conduct payment transactions, QuickBooks Point of Sale does so using SSL-protected connections.

If you transmit data using the options available within QuickBooks Point of Sale, this encryption ensures a secure transmission.

Also, when using the transmission options included within QuickBooks Point of Sale:

- Card swipe data is never transmitted;
- No card data is sent between stores in a multi-store configuration.
If Your Data is Requested by Intuit

Occasionally, it may become necessary for a user to submit data files to Intuit Technical Support for troubleshooting or data recovery. Intuit maintains a written policy governing how your data is collected, transmitted, stored, and used for support purposes in a secure manner. Highlights of this policy include:

- Intuit does not request magnetic strip data, card validation codes or values, PINs, or PIN block numbers for any support purposes
- Cardholder or authentication data is collected only with your express permission and only when needed to solve a specific issue
- Collection is limited to the data needed to solve the specific problem
- Data is encrypted and stored in a limited-access location while in use
- Data is securely deleted immediately after use
- Intuit’s use of the data is further governed by the QuickBooks Point of Sale Privacy Policy, which you can review from the Help menu within Point of Sale.

If You Share Your Data with Other Parties (such as System Integrators)

If you transmit or share your data file outside of QuickBooks Point of Sale, such as with an accountant or technical advisor, it is your responsibility to understand and follow the PCI DSS requirements for the security of such transmissions.

You should never e-mail or transmit unencrypted cardholder data; this data should be transmitted only in an SSL-encrypted format.

We strongly recommend you familiarize yourself with the requirements outlined at http://www.pcisecuritystandards.org and the additional security resources included in Table 3.
Maintaining a Vulnerability Management Program

Windows Update
Microsoft routinely releases Windows and other application software updates to address security issues. These security patches should be installed to maintain a high level of system protection.

Find out more about Windows security and Windows Update services from Microsoft at http://www.microsoft.com/security/.

QuickBooks Point of Sale Updates
Updates to this version of QuickBooks Point of Sale are released periodically to add or enhance functionality and to fix identified defects. If there are changes in PCI DSS requirement or in related QuickBooks Point of Sale features, the updates will include updated electronic documentation, including this guide, to help you stay in compliance. Check the “What’s New” release notes and electronic version of this guide periodically for updated information (select What’s New and User Guides from the Help menu in Point of Sale).

It is strongly recommended that you enable the automatic update preference in QuickBooks Point of Sale and consider upgrading to new versions as they are made available to stay current and in compliance with PCI DSS standards.

Intuit does not remotely connect to your network, without your permission, to “push” program updates to you. You have complete control over when and how QuickBooks Point of Sale updates are downloaded and installed to your system.

To review or change your QuickBooks Point of Sale update preferences:
1. From the Help menu, select Software Updates > Updater Preferences.
   The Updater Preferences dialog is opened.
2. Select an update notification level.

   We recommend you select **Download only. Let me choose when to install**. With this choice, updates are downloaded anytime you are connected to the Internet, but you can install them at your convenience.

3. If you have multiple workstations, we recommend you select the **Shared Downloads** tab and choose the option to update all workstations from a single download location.

4. Select **OK**.

   **Note**: All workstations must install the updates to maintain access to the data file and remain current with any included PCI compliance changes. The shared download option can be useful for this purpose if you have workstations without direct Internet access.

**Manually Downloading Updates**

If you choose not to enable automatic notification of QuickBooks Point of Sale updates, you are encouraged to manually check for and download updates from [http://support.quickbooks.intuit.com/support/productupdates.aspx](http://support.quickbooks.intuit.com/support/productupdates.aspx). Click on the **Product Updates** tab and review the available Point of Sale updates.
Antivirus Software

Install anti-virus and spyware detection software and keep it up to date.

These software products are designed to detect and remove malicious software code that typically is installed on your computer without your knowledge or permission for the purpose of damaging files or data, intercepting sensitive information, or tracking your computer and Internet activities.

You can learn more about this type of software and related information from the sites listed in Table 3.
Implementing Strong Access Control Measures

About System Administrators

Operating System (Windows): Your Windows Administrator account must be protected with a complex password and should be used only when required to complete tasks that are limited to the administrator. At all other times, you should log in as a limited-rights user to help prevent unauthorized access to the administrative areas of your operating system.

In addition, you must implement Windows user account controls, including password, account lockout, and automatic logout policies following the requirements outlined in Appendix A.

Following the requirements in Appendix A is an absolute requirement to control access to the QuickBooks Point of Sale Server Workstation, which holds your company data and the database server applications used to access the data.

Point of Sale: In QuickBooks Point of Sale, only the SysAdmin user can turn on/off the requirement of password logins to use the program, add employees and define their initial password, access all data and features (except encrypted card information), or perform certain data-sensitive tasks. It is strongly recommended that you use complex passwords for the SysAdmin user.

As with Windows, you should not use the QuickBooks Point of Sale SysAdmin user account for routine tasks. This user account should be used for application administration purposes only.

Never leave your computer unattended when an administrator user is logged in!

Protecting Your Data with Unique IDs and Passwords

Your security system will be most effective when all activities by each user on the system can be accounted for and tracked. Requiring user names and password logins is one of the easiest steps you can take to protect your data.

QuickBooks Point of Sale, like any other Windows application, relies on security features within Windows to help protect your data. For the best protection, you must set up unique user accounts/names and passwords for logins to both Windows and QuickBooks Point of Sale.

Note: See Appendix A for information on configuring your Windows user accounts, lockout policies, and automatic logouts.

In QuickBooks Point of Sale, we strongly recommend “complex” passwords for all users and all processes. This is especially important for:

- The QuickBooks Point of Sale system administrator (SysAdmin) user who has access to virtually all QuickBooks Point of Sale data and features;
- Processes, such as sending Store Exchange files between stores;
• Any data shared with advisors or accountants via e-mail or public networks.  

*Note: While QuickBooks Point of Sale does not enforce complex passwords for the SysAdmin user, it is a PCI requirement for compliance if you are processing card payments.*

**What is a complex password?**

For purposes of QuickBooks Point of Sale, a complex password meets the following rules (this may vary with other programs):

- Is at least seven characters long;
- Includes at least one each of:
  - Numerals (0-9)
  - Upper-case letters (A, B, C)
  - Lower-case letters (… a, b, c)
  - Special symbols (characters other than letter or numbers)
- Is changed at least every 90 days;
- Does not reuse any of your last four passwords.

In addition, you should follow good practices for authentication and password management, as follows:

- Restrict addition, deletion, and modification of user IDs, passwords, and other identifiers to actual users or administrators;
- Verify user identity before allowing password resets;
- The SysAdmin should initially set user passwords to a unique value and require users to change it immediately after first use;
- Immediately revoke access of terminated users and remove inactive user accounts every 90 days;
- If you allow vendors or advisors to access your systems remotely, provide them with active accounts only for the duration of time required for them to perform their services;
- Communicate your password procedures and policies to all users that have access to cardholder information;
- Do not use group, shared, or generic accounts or passwords;
- Enable automatic logouts after 15 minutes of no activity on your QuickBooks Point of Sale workstations, requiring users to re-login in order to continue.
From the Edit menu, select **Preferences > Workstation**, and then select **General** from the left-side menu to access this setting. This preference must be set on each workstation independently.

**Other Password Recommendations**

From a practical standpoint, the most important thing about a password is that others cannot easily guess it or figure it out.

Today’s techno-thieves have powerful password-guessing software at their disposal. While password protection may be the easiest step you can take to protect your data, it is also one of the easiest links for them to crack if you do not invest the effort to make your passwords complex and strong.

Other considerations when coming up with passwords include the following. We recommend you make these suggestions part of your password policy that you share with employees and others that have access to your data:

- Use a password that you can remember, but don’t use your name, user name, business name, your birth date, your address, or anything else that could be easily guessed.
- Avoid other common words and names.
- Do not write your password down and leave it near your computer. If you do write down your password, lock it away in a safe or store it off-site.
- Be creative and unpredictable.

**Example:**

“mypassword” is a very weak password

“mio+dRow88ap” is much stronger, though similar.

**Explanation:** “mio” = “my” in Italian, the + is a symbol with no meaning, “password” is still there but spelled backward with the letter “s” replaced with 8’s and the R made upper-case.

Such a password would foil the average hacker and slow down all but the most sophisticated password-cracking tools.
Creating Your Passwords in QuickBooks Point of Sale

You are prompted to create a SysAdmin password when you turn on the company preference requiring users to log in to use the program and again anytime you toggle this option off/on. Enter a complex password of at least seven characters.

Once turned on, only the SysAdmin can change this setting, add new employees, and perform certain other data-critical tasks.

Creating Passwords for Employees

Only the SysAdmin can add a new employee, assign login names, and create initial passwords.

1. From the Employees menu, select Employee List.
2. Select New Employee.
3. Enter a Login Name and other employee information and then select Create Password. Enter a unique initial password for the employee.
4. Select Save.

New employees should be required to change the SysAdmin-assigned password the first time they log in using the option below.

Employees Changing Their Own Password

Once defined, any user can change his/her own password at anytime. To do so, log in with your current password and then from the Employee menu, select Change Employee Password. You must enter your old password before you are allowed to create a new one.

The SysAdmin can change any employee’s password by editing the employee record.

Restrict Access with Security Rights

QuickBooks Point of Sale provides security controls that allow you to restrict access of your employees to hundreds of program areas, sensitive data, and reports. We strongly recommend you take advantage of these security controls to protect your data.

Note: Encrypted card information stored in QuickBooks Point of Sale is never accessible by any employee, including the SysAdmin, or available on reports, logs, or documents whether you choose to use the other security features or not.
Configure QuickBooks Point of Sale security rights for your employees as appropriate for your business.

**To assign security rights in QuickBooks Point of Sale:**

1. From the Employees menu, select **Security**. The Security window displays the list of rights you can assign.

2. Grant or remove rights to perform a task or view data by selecting or clearing the check-boxes, respectively, in the security group columns.
   - There are four predefined groups, **Owner**, **Manager**, **Assistant Manager**, and **Associate**, with default rights being highest for the Owner and then progressively lower for the other three groups. You can change the rights for these default groups or create new groups and assign the rights you deem necessary.
   - Change the selection in the **View** drop-down list to show the available rights by program area.
   - Take special care when assigning employee rights for access to data-related tasks or to edit these security controls. For security purposes, it is important that only people you select and trust have access to these functions.

3. From your employee list, add employees with unique login names and passwords as described earlier and then assign them to a security group as appropriate.

4. If not already enabled, turn on the company preference requiring users to log in. When an employee logs in, only the program areas, tasks, and data you have given them rights to will be available.

**When an Employee Leaves**

When an employee leaves your company, disable their account immediately by deleting the employee record so that no further access to your data through that user name and password is possible (if you wish to keep the employee record, change their password and reassign them to a security group with no rights).
Limiting Physical Access to Your Data Files

Anyone with access to the computer with your data file may be able to retrieve data from that file be it by theft or unauthorized access.

For this reason, we recommend you limit physical access to the computer with your data file to employees on a need-to-know basis.

This is best accomplished with a network configuration that places your QuickBooks Point of Sale Server Workstation in a secured location. If this computer has an Internet connection, ensure it is protected by firewall and anti-virus software as outlined in this guide.

Employees will still be able to perform tasks for which they have security rights across the network, but the computer and hard drive that actually holds your data is more physically secure.

Scheduling Tasks in QuickBooks Point of Sale

Certain QuickBooks Point of Sale tasks, such as data backups and Store Exchange of information, can be scheduled to occur when your computer is unattended. This allows you to perform these tasks during off-hours, when network or Internet traffic and overhead costs are lower. However, you should be aware that this practice carries additional security risks because the QuickBooks Point of Sale Server Workstation must be running with a user logged in for the scheduled tasks to be completed.

If you are scheduling tasks to occur when your computer is unattended, special precautions should be taken, including:

- Set up a user with security rights to only the scheduled tasks, and log in as this user before leaving your computer.

- Use the Windows “lock” feature to effectively “lock the door” on your computer during the time it will unattended. For most versions of Windows, assuming you have set up user accounts and passwords, you can lock your computer by simultaneously pressing the Windows logo key + L on your keyboard.

Note: Depending on your Windows version and configuration, and your keyboard layout, this procedure may vary. Consult your Windows help system if this key combination doesn’t work for your particular setup.
Review Security Logs Regularly

QuickBooks Point of Sale automatically logs all data access, data security, card transactions, and encryption key changes to its own Audit Log or to the Windows Event Log; you do not need to turn this feature on manually.

We recommend you review these logs daily (or as often as possible) to comply with the PCI security standards.

Windows Event Log

Because the QuickBooks Point of Sale database, and thus the Audit Log, is not accessible until a user successfully logs in to QuickBooks Point of Sale, unsuccessful attempts to start and log in are recorded in the Windows Event Log.

If you have your Windows user controls set appropriately, only an administrator-level user should have access to this log.

To check the Windows Event Log:

1. From the Windows Control Panel, select Administrative Tools and then Event Viewer.

2. Select Application from the options on the left of the window.

   To see only QuickBooks Point of Sale log entries: From the View menu select Find, select the check-box for Failure Audit only, choose “QuickBooks Point of Sale” as the Event Source and then select Find Next to display matching entries.

3. To view more detail, including the computer from which the attempt was made, right-click an entry and select Properties.
QuickBooks Point of Sale Audit Log

After logging in to QuickBooks Point of Sale, all security activities are recorded in the internal Audit Log. Only the SysAdmin can view this log.

To view the Audit Log:

1. Log in as the SysAdmin user.
2. From the Point of Sale File menu, select Utilities > View Audit Log.
3. Use normal QuickBooks Point of Sale report options to change the appearance or filter the Audit Log report by date, user, or other included data. Refer to the QuickBooks Point of Sale help system for instructions to modify reports.
4. When done, close the report and log off as SysAdmin.

QuickBooks Point of Sale 2013 Audit Log Files

Starting from QuickBooks Point of Sale 2013, application also collects information in additional files in a log directory. These logs are kept indefinitely, grouping all log information into one file for each day. Merchants can setup a process to send collected files from different locations to a central repository in order to be kept in a secure remote location for security and forensic purposes.

<table>
<thead>
<tr>
<th>OS Version</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP, Windows Server 2003</td>
<td>C:\Documents and Settings\All Users\Shared Data\QuickBooks Point of Sale 11.0\Log\Audit</td>
</tr>
<tr>
<td>Windows Vista, Windows 7, Windows Server 2008:</td>
<td>C:\ProgramData\Intuit\QuickBooks Point of Sale 11.0\Log\Audit</td>
</tr>
</tbody>
</table>
Maintaining an Information Security Policy

Keep Up with Emerging Security Standards

Merchants accepting credit and debit cards for payment are now required to comply with the Payment Card Industry (PCI) security standards. Find out more about these standards at https://www.pcisecuritystandards.org.

Emergency Preparedness

Back Up Your Data File Frequently

Back up your data daily and before running tasks that change your data in a significant way. Keep the backup files in a safe location, preferably off-site in a fireproof safe, or at a business records management facility.

Install Uninterruptible Power Supplies (UPS)

A UPS helps ensure data integrity in the event of a sudden power loss by providing a few critical minutes of backup power in which you can complete and save in-progress transactions. Without a UPS, these transactions are usually lost and, as with any software, the data file can become corrupt if disk-write operations were in progress when the power was lost. We recommend a UPS on each QuickBooks Point of Sale workstation, but most importantly on the Server Workstation, which stores your data.

Keeps your Business Running when Disaster Strikes

Only trusted people in your company should perform administration of your QuickBooks Point of Sale data file and system configuration. If you allow a temporary or limited-skill employee to install and set up QuickBooks Point of Sale, they may not be capable of supporting you in a critical data security situation.

Plan for situations where your trusted technical advisor or accountant is unavailable. Remember that the QuickBooks Point of Sale system administrator (SysAdmin) account and password are critical to the operation and protection of your business, and you should handle this account with care.

If your data file is damaged, or the SysAdmin password is compromised or lost, and you purchase data recovery services from Intuit, Intuit may need to contact the owner of the business to recover your company data file, for security reasons. You can review the QuickBooks Point of Sale Security Policy that governs our access to your data file from the Help menu in QuickBooks Point of Sale.
Further Information

Table 3: Security Web Sites

Intuit does not endorse or specifically recommend any of the products listed in the table below. Security recommendations should take into account relevant factors that may be unique to your business. No single product or security technique by itself will assure complete protection of your data. Combinations of the products and practices listed here will help to protect your QuickBooks Point of Sale data.

Additional information may be obtained by using your favorite search engine to search for anti-virus, firewall, and other security products.

<table>
<thead>
<tr>
<th>Web Site</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.staysafeonline.info">www.staysafeonline.info</a></td>
<td>A government-industry sponsored site to educate the public on computer security. Look for advice for small businesses under the “Beginners Guides.”</td>
</tr>
<tr>
<td><a href="http://www.consumerreports.org">www.consumerreports.org</a></td>
<td>Consumer Reports has issued ratings on personal firewalls and anti-virus software; search for “firewalls,” and “anti-virus” for more details.</td>
</tr>
<tr>
<td><a href="http://www.cisecurity.org">www.cisecurity.org</a></td>
<td>This site is for IT professionals looking for best practices documents for system configuration.</td>
</tr>
<tr>
<td><a href="http://www.cert.org/homeusers">www.cert.org/homeusers</a></td>
<td>This site offers an excellent set of guidelines issued by the Computer Emergency Response Team at Carnegie Mellon University for home (and small business) users.</td>
</tr>
<tr>
<td><a href="http://www.getnetwise.org">www.getnetwise.org</a></td>
<td>Refer to the sections on wireless networking and remote access for security advice.</td>
</tr>
<tr>
<td><a href="http://www.pcisecuritystandards.org">www.pcisecuritystandards.org</a></td>
<td>The official site for the Payment Card Industry Data Security Standards.</td>
</tr>
</tbody>
</table>

How to Contact Us

If you need technical assistance, with your QuickBooks Point of Sale software please select Help & Support from the Help menu within QuickBooks Point of Sale to learn about the various free and assisted support resources available to you.

You may also use the following QuickBooks POS Merchant Account resources:

- To learn more about a Merchant Service Account, visit us at http://payments.intuit.com
- To get help with an existing account, call 800-558-9558, 24 hours a day, 7 days a week. Free support for account holders.
Appendix A: Windows Account Security

In all recent versions of Windows, from Windows 2000 to Windows 7, account policy settings have been available to mitigate risks associated with attacks on Windows authentication. In order to comply with PCI Data Security Standards, you should configure your systems as described below.

In addition to the following, when you assign passwords to new users:

- Select the option to require the user to change their password at next login. Accounts for employees that leave your company must be disabled immediately, and inactive accounts should be removed at least every 90 days.
- If you allow vendors or contractors to access your systems remotely, provide them with accounts (in compliance with these settings) only for the duration of time required for them to perform their services.
- You should communicate password and authentication security policies to all employees of your company that have access to cardholder information. When they select passwords for their accounts, they will need to choose their password carefully to meet the PCI security standards.

Before you make these settings, be aware of the following considerations and situations where account policies may affect how you operate your business. Some points apply only to domain accounts; if your computers operate in a workgroup or stand-alone configuration, some points may not apply. Please read these points carefully and review your practices to head off problems.

1. Don’t share accounts. If the same domain account is logged in on more than one machine, and another user attempts to login to another machine after the password has been changed by one user, other users may lockout the account.

2. Avoid resetting of passwords by the Windows administrator. While this is sometimes unavoidable, when user passwords are reset by the Windows administrator, you may find that data protected using some Windows encryption facilities will not be recoverable. For example, under Windows EFS (Encrypting File System), any data encrypted for an account provisioned with the old password will be unrecoverable under the new password. Similarly, data encrypted with the Windows Data Protection APIs will also be unrecoverable after the administrator resets the user’s password.

3. Be careful when configuring lockout on publicly accessible machines. For any system that’s accessible by a large population of people in your company, where the accounts on that machine are used elsewhere, be aware that someone can place that account in a lockout state on that machine that affects all other machines in your domain.

4. Periodically examine all user accounts on your system to determine their password age and their lockout status. Microsoft has a number of tools available to assist you in securing your Windows systems. Among the tools you may find useful are:
a. **LockoutStatus.exe**: This tool displays a list of locked out users and the last time they attempted to login, the number of times they failed to login and the domain controllers that were referenced in authentication.

b. **ALockout.dll**: This is a logging component that will assist you in determining which application or service is using an incorrect password and causing an account to enter a lockout state. For example, this tool may be useful in identifying background processes that are being locked out because of outdated credentials.

These and other tools are available in the **ALTools.exe** collection of tools to manage authentication in your Windows domain. This is available from Microsoft: [http://www.microsoft.com/downloads/details.aspx?FamilyID=7af2e69c-91f3-4e63-8629-b999adde0b9e&DisplayLang=en](http://www.microsoft.com/downloads/details.aspx?FamilyID=7af2e69c-91f3-4e63-8629-b999adde0b9e&DisplayLang=en)


Microsoft recommends that you do not exempt the privileged accounts from password policies. Your privileged accounts should have complex passwords, an expiration period, and the passwords should be a minimum of 15 characters in length. Microsoft also recommends that you also protect the local accounts (non-domain clients) by using a local password policy for all users. For all workstations in a domain, set a domain-level Group Policy and filter it to apply to the domain member computer.

### Configuring Local User Accounts to be PCI Compliant

For a stand-alone workstation, set the appropriate registry values by configuring the local policy:

1. Select **Start** and then **Run**, type **gpedit.msc**, and then press **Enter**.

2. In the Group Policy editor window, select **Computer Configuration > Windows Settings > Security Settings > Account Policies** and then either **Account Lockout Policy** or **Password Policy**.

3. On the right, right-click the setting that you want to change, and then select **Properties**.

4. If you are defining this policy setting for the first time, select **Define this policy setting**.

5. Select the options that you want, and then click **OK**.

   See recommended setting for PCI compliance below.
Setting Password Policies

Figure 2 - Password Policy Setting

Figure 2 shows default Password Policy values you are likely to see when first opening the Group Policy editor. PCI Standards recommend the following settings:

- Enforce password history: 4 passwords remembered:
- Maximum password age: 90 days:
- Minimum password age: 0 days:
- Minimum password length: 7 characters:
- Password must meet complexity requirements: Enabled:
- Store password using reversible encryption: Disabled.

These settings will require that each employee of your company select a Windows password that’s 7 or more characters in length, and comply with the following complexity rules:

- Do not contain all or part of the user's account name.
- Contain characters from three of the following four categories:
  - English uppercase characters (A through Z):
  - English lowercase characters (a through z):
  - Base-10 digits (0 through 9):
  - Non-alphanumeric (for example, !, $, #, %). extended ASCII, symbolic, or linguistic characters.
Setting Account Lockout Policies

Figure 3 shows default Account Lockout values you are likely to see when first opening the Group Policy editor. PCI Security Standards recommend the following settings:

- Account Lockout Duration: 30 (minutes);
- Account Lockout Threshold: 6 invalid login attempts;
- Reset account lockout counter after…: 30 (minutes).

Setting Session Idle Time and Screensaver Options

To set session idle timeout behavior to be compliant with PCI Security Standards, configure your screen saver to engage after no more than 15 minutes of idle time. You should also set the option to prompt for a password to resume the session.
Appendix B: Encryption Key Management

1. **QuickBooks Point of Sale complies with PCI security standards that require cardholder information be encrypted using standard algorithms and encryption key lengths.**

   When you initially create your QuickBooks Point of Sale company data, an encryption key is automatically created by QuickBooks Point of Sale. This encryption key is used to encrypt payment card numbers using 1024-bit RSA encryption.

   This key is automatically re-generated once per year by QuickBooks Point of Sale and can also be manually generated by you at anytime if a data security breach is suspected (See If You Suspect a Security Breach).

2. **Permissions to use encryption keys should be properly controlled, according to the PCI standards. QuickBooks Point of Sale internally controls access to the encryption key, which supports the PCI standards.**

   The QuickBooks Point of Sale encryption key is actually made up of a pair of keys: a public key and a private key. When a card transaction is authorized in QuickBooks Point of Sale, the program internally uses the public key to process the authorization. When settling card transactions, QuickBooks Point of Sale internally uses the private key and the System Administrator (SysAdmin) credentials to complete the settlement process.

   This key pair never leaves the company file and the private key is never stored unencrypted. Access and use of the private key is limited to the SysAdmin account.

   This is yet another reason why it is important to restrict access to your SysAdmin account, protecting it with a complex password that is changed frequently, never leaving your computer unattended with this user logged in, and used for administration purposes only.

3. **Data encryption keys must be stored in a secure manner, to meet the PCI requirements and to properly protect your customers’ credit card information.**

   QuickBooks Point of Sale manages the storage of encryption keys in the company file automatically. In doing this, the private key is always stored in an encrypted fashion. The key management hierarchy previously described is applied to protect the stored credit card numbers for each customer.

4. **Key rotation is required in order to be compliant with the PCI Security standards.**

   Key rotation is a term used to refer to the practice of periodically replacing older keys with newer keys. In the event that an encryption key is disclosed, a new key is used to replace it. Rotating keys periodically reduces the risk that the value of the key will be discovered, allowing the decryption of the data protected by that key.
QuickBooks Point of Sale automatically re-generates the encryption keys once per year and you can also manually generate new keys at anytime if a data security breach is suspected (See If You Suspect a Security Breach).

Note: The PCI security standards require that the QuickBooks Point of Sale administrator change their password every 90 days. QuickBooks Point of Sale has been designed in a manner to minimize the set of actions that the QuickBooks Point of Sale administrator needs to follow in order to be PCI-compliant.

5. When old keys are no longer used to protect data, the PCI standards dictate that these keys be destroyed.

Destruction of old keys helps avoid cases where a key might be recoverable and applied to an old copy of the company file (encrypted with the old key).

When new data encryption keys are generated in QuickBooks Point of Sale, automatically or manually, the new keys overwrite, and therefore delete the old keys and render them unrecoverable.

6. Within very large businesses with extensive business systems, a common implementation pattern is to apply dual-control of keys.

Under dual-controls, two (or more) people need to be present in order to unlock a key for use.

Since the target market for QuickBooks Point of Sale is small businesses that may not have dedicated IT staff, no dual control of keys has been implemented.

7. QuickBooks Point of Sale prevents substitution of an unauthorized key for another (authorized) version of the key. QuickBooks Point of Sale also prevents swapping of rogue data in the company file with another piece of information.

When keys and credit card data are encrypted and stored in the company file, information describing that data is also encrypted and stored. The data, and the data describing the data, are encrypted and stored as a single unit. When the data is decrypted, QuickBooks Point of Sale performs checking on the decrypted data to be sure that only valid data is retrieved from the database.

8. What to do when you suspect your data has been compromised, or if you wish to refresh all encryption keys within QuickBooks Point of Sale.

If you suspect that your customers’ data has been compromised, you need to take immediate action to disable the account of any suspected user(s) as well as generating new encryption keys. Consult the QuickBooks Point of Sale audit log to examine the activity related to the compromised data. See If You Suspect a Security Breach for additional information.
Appendix C: Disabling System Restore Points

To prevent storing clear text cardholder data, or sensitive authentication data, any systems that are running Windows XP, Vista or 7 along with payment applications should have Windows System Restore Points disabled. This will prevent violation of PCI DSS requirement 3.2.

Disabling System Restore Points in Windows XP

Instructions for disabling System Restore points are documented in Microsoft Knowledge Base article 310405 accessible here: [http://support.microsoft.com/kb/310405](http://support.microsoft.com/kb/310405)

You will follow these steps:
1. Click Start, right-click My Computer, and then click Properties.
2. In the System Properties dialog box, navigate to the System Restore tab.
3. Select the Turn Off System Restore checkbox.

Disabling System Restore Points in Windows Vista

For Windows Vista, Microsoft has described how to disable system restore points at the following URL:


In short, follow the following steps:

- Click Start, select Control Panel, select System and Maintenance and select System
- Click System Protection
- Enter the administrator password
- Uncheck the System Restore check-box next to all disks

Disabling System Restore Points in Windows 7

The following steps can be used to disable System Restore Points on Windows 7

- Click Start, right-click Computer, and then click Properties.
- In the left pane, click System Protection.
- Enter the administrator password.
- Under Protection Settings, select the disk, and then click Configure.
- Choose the radio button labeled “Turn off system protection”.
- Click OK, and then click OK again.